Table of Contents

1. Introduction .......................................................................................................................... 4
2. Installation ............................................................................................................................. 4
   2.1 System requirements .......................................................................................................... 4
   2.2 Downloading .................................................................................................................... 4
   2.3 Installing .......................................................................................................................... 5
3. Using the Plugins .................................................................................................................. 6
   3.1 Workflows ......................................................................................................................... 6
   3.2 Available Hosts ................................................................................................................. 7
      3.2.1 Max/MSP ..................................................................................................................... 7
      3.2.2 Reaper ......................................................................................................................... 7
4. The EigenUnits ...................................................................................................................... 9
   4.1 Overview ............................................................................................................................ 9
   4.2 EigenUnit-em32-Control ................................................................................................. 10
   4.3 EigenUnit-em32-Encoder ............................................................................................... 12
   4.4 EigenUnit-em32-Beamformer ......................................................................................... 14
5. Appendix ................................................................................................................................ 16
   5.1 Eigenbeam Ordering and Normalization ........................................................................... 16
   5.2 Troubleshooting ............................................................................................................... 17
1. Introduction

The EigenUnits plugins comprise a set of standalone Virtual Studio Technology (VST) plugins that can be used in conjunction with the em32 Eigenmike® microphone array hardware.

These software plugins can be used on their own, or combined with other readily available third-party Ambisonic plugins (e.g. with other HOA decoders). Their modular nature, and the ability to host and incorporate the plugins in many standard DAWs provides a large degree of flexibility for assembling a custom signal processing chain for the em32 microphone array.

Available plugins:

- **EigenUnit-em32-Control**
  - controls microphone input PGA (programmable gain amplifier) level and sensor calibration via the em32/EMIB hardware

- **EigenUnit-em32-Encoder**
  - encodes the microphone input signals into Eigenbeams (spherical harmonics, Higher-Order Ambisonics signals)

- **EigenUnit-em32-Beamformer**
  - applies beamforming, with pattern, order, and steering direction control

2. Installation

The EigenUnits plugins can be easily installed or updated via the installer package.

2.1 System requirements

- macOS 10.10 or higher, or Windows 10 64-bit
- VST compatible hosts (64-bit versions)
  (e.g. Cycling 74’s Max/MSP, or Cockos Reaper)
- An em32 Eigenmike® microphone array system (or a 32-channel recording from an em32, for offline processing) consisting of the em32 array and the EMIB

2.2 Downloading

The latest EigenUnits installer package can be downloaded directly from the mh acoustics web site: [https://mhacoustics.com/download](https://mhacoustics.com/download)

---

1 Eigenmike Interface Box – an audio interface that connects the em32 to a computer using FireWire (or via Thunderbolt when using the Apple Firewire-to-Thunderbolt converter).
2.3 Installing

To install the EigenUnits plugins and supporting files, open the downloaded installer (dmg or zip) by double-clicking, and then open the included package installer (pkg or directory). Follow the prompts to be guided through the installation process (macOS), or copy the plugins to your preferred location (Windows).

![Figure 1: The EigenUnits installer](image)

On macOS, the EigenUnits VST plugin files are installed to:

VST3: /Library/Audio/Plug-Ins/VST3/

On Windows, the plugins can be stored in any location, as long as the host’s paths match. For example:

VST3: C:\Program Files\Common Files\VST3\
Once these files are installed, they can be found and loaded by a variety of VST-capable hosts (Max/MSP, Reaper, Bidule, etc.). The locations of VST3 plugins should be set (if not already) in the host’s preferences in order for the host to successfully detect plugins. You may need to restart your application or re-scan plugins before they appear and are available to the host software.

3. Using the Plugins

The EigenUnits plugins can be used in many commonly available digital audio workstations ("DAWs") that support the hosting of VST plugins.

The EigenUnit plugins can be configured to run at sampling rates of either 44.1kHz or 48kHz. These are the only sampling rates supported by the EigenUnits as well as the em32 Eigenmike and EMIB hardware.

EigenUnits, like most audio plugins, are capable of processing the input signals at various block sizes, as defined by the DAW host software. Larger block sizes result in more overall system latency but decrease the demand placed on the processor. Smaller block sizes reduce latency but require more computational power. If audio dropouts are observed in a processing chain, especially on older, slower computers, increasing the block size may help.

A set of example projects for Max and Reaper, along with a detailed description of how the plugins are used are also included in the installer package.

On macOS, these will be automatically installed to:

/Applications/mh acoustics/EigenUnits/EigenUnits Examples/

On Windows, the project files can be manually copied by the user to any convenient location. See the "EigenUnits Examples" document for more details.

3.1 Workflows

The VST plugins are typically used as effects on tracks. For instance, one could use the Control and Encoder plugins on a track that had the em32’s microphones as the input, yielding the encoded Eigenbeams (Ambisonic signals) as the output.

Due to the modularity of the plugins, they can be easily combined with other third-party plugins and tools. For example, the EigenUnit-em32-Encoder could be followed by a custom HOA decoder. Many signal chains are possible, but it is important to understand the performance requirements and limitations of each component for both compatibility and optimal performance. See the description of the individual EigenUnits for more detail.
3.2 Available Hosts

Any 64-bit DAW capable of hosting VST plugins and supporting high-channel count tracks (i.e. at least 25 or 32 channels per track) should be able to host the EigenUnits.

These include: Cycling 74’s Max/MSP\(^2\), Plogue Bidule\(^5\), and Cockos Reaper\(^6\).

Other commonly used DAWs such as Logic, Cubase, Neundo, and Audition are currently not compatible with the EigenUnits plugins, since these DAWs do not support high-channel count tracks (i.e. a 32-channel track for the input, or a 25-channel track for the Eigenbeams).

3.2.1 Max/MSP

In Max/MSP, instances of VST plugins can be created using the \texttt{vst~} object. Create MSP objects using the following arguments to use the EigenUnits plugins:

\begin{verbatim}
  vst~ 32 32 EigenUnit-em32-Control
  vst~ 32 25 EigenUnit-em32-Encoder
  vst~ 32 1 EigenUnit-em32-Beamformer
\end{verbatim}

3.2.2 Reaper

In Reaper, to add an instance of an EigenUnit plugin to a track, simply go to the track FX browser and double-click on the desired plugin. Make sure to use an appropriate channel count and routing for the plugin you are using.

\(^2\) \url{https://cycling74.com/products/max/}
\(^3\) Max/MSP version 8.0 or greater is required for VST3 support.
\(^4\) Note, as of Max 8.1.1, VST3 support on Windows does not yet support the “bundle” style VST3 plugin, thus the VST3 EigenUnits will not work. The older style VST2 (*.dll) plugins can still be used. However, support for the MADI extension card is limited to the VST3 plugins.
\(^5\) \url{https://www.plogue.com/products/bidule/}
\(^6\) \url{http://www.reaper.fm/}
Figure 2: The Reaper FX browser
4. The EigenUnits

4.1 Overview

EigenUnits plugins can be used together or separately combined with other readily available third-party plugins (e.g. with other HOA decoders). Their modular nature, and the ability to host and incorporate the plugins in many standard DAWs provides a large degree of flexibility for assembling a custom signal processing chain for the em32.

An example signal chain might utilize the EigenUnits to realize a steerable, directional beamforming microphone (see figure below). Another use might extend this to include multiple beamformers for recreating typical coincident stereo recording techniques. Yet another use might utilize the Control and Encoder plugins, followed by an HOA Decoder for a custom speaker layout. The following sections describe each of the EigenUnits in detail, along with usage consideration.

Figure 3: Block diagram of one possible signal flow
4.2 EigenUnit-em32-Control

The EigenUnit-em32-Control VST plugin accepts the 32 microphone signals from the em32/EMIB hardware and applies the factory-measured calibration values that are stored inside each em32. These values are used to compensate for microphone mismatch to improve subsequent Encoder or Beamformer performance. This plugin also provides control of the hardware programmable gain amplifier (PGA) level setting. The PGAs support a gain setting of -10dB to +30dB in 1dB increments.

![Figure 4: The Control plugin user interface](image)

If a valid factory calibration setting is detected in the hardware, it will be applied to the signals. When using a Firewire connection, the calibration values are applied in software by the plugin; the 32-channel output from the plugin will be the resulting calibrated signals, and is suitable for recording or for further processing. When using a MADI connection, the calibration values will be applied in hardware to the MADI stream (and not by the plugin). If the em32/EMIB hardware and calibration values are not detected, the plugin will pass the signals through unaltered. Thus, if using a prior recording of calibrated signals rather than a live stream, the plugin does not need to be removed from the signal chain.

Note this plugin should **not** be used together with em32setGain or EigenStudio, as that may result in the calibration values being applied multiple times. For more information, see the document "Best Practices for Recording with the em32" [7].

---

The EigenUnit-em32-Control plugin has the following parameters:

- **EMIB Detected** – this indicator will reflect the status of the connection to the Eigenmike® Interface Box (EMIB) hardware

- **em32 Detected** – this indicator will reflect the status of the connection to the em32 microphone array hardware

- **em32 Serial Number** – if the em32 microphone array hardware is attached and detected, this will display the serial number of the microphone

- **Calibration Status** – this indicator will reflect the status of the automatic microphone calibration. If the em32 microphone array hardware is attached and detected via Firewire, this indicator will be green and calibration values will be applied by the plugin to its software outputs. If hardware is attached via an audio interface utilizing the MADI expansion, the indicator will be green and calibration values will be applied in hardware to the MADI signals. If the hardware is not attached, this indicator will be gray, and the calibration values will not be applied.

- **MADI Connected** – this indicator will be green when hardware is connected via an audio interface utilizing the MADI expansion card in the EMIB.

- **PGA Gain** – this slider allows the setting the programmable gain amplifier (PGA) level when the em32 hardware is present and detected. Note this is a hardware gain at the front-end of the signal chain, and should always be used before software gains in order to maximize SNR. Gain values are selectable in 1dB increments from -10dB to +30dB.

---

8 Note, when using Max/MSP (as of version 8.1), you may need to click in the plugin GUI area once to refresh the status of the indicators.
4.3 EigenUnit-em32-Encoder

The EigenUnit-em32-Encoder VST plugin accepts the 32 calibrated microphone signals from the Control plugin (or from file) and converts them to Eigenbeams (HOA signals, spherical harmonics) up to 4th-order. These 25 output signals can then be sent to other plugins for further processing (or recorded to file).

![Figure 5: The Encoder plugin user interface]

A special note on the general nature of encoded Eigenbeams: Due to physically-based limitation constraints, the 2\textsuperscript{nd}, 3\textsuperscript{rd}, and 4\textsuperscript{th}-order Eigenbeams are highpass filtered. For the five 2\textsuperscript{nd}-order Eigenbeams the cutoff frequency is set to 400Hz; for the seven 3\textsuperscript{rd} order Eigenbeams the cutoff is at 1kHz; for the nine 4\textsuperscript{th} order Eigenbeams the cutoff is at 1.8kHz.

The EigenUnit-em32-Beamformer plugin (see below) takes special care to weight these signals appropriately in a frequency-dependent manner to account for this. However, many third-party plugins apply frequency-independent (scalar) weights when combining the Eigenbeams in beamforming and decoding applications. Care should be taken when using such third-party tools to account for this issue, which is specific to live HOA recording but does not exist in simulated and synthesized HOA content.

At the upper end of the spectrum, the Eigenbeam validity is limited by the spatial Nyquist frequency that is determined by the average spacing of the individual microphones in the array. For the em32, this corresponds to approximately 9kHz. Above this frequency, the spatial response of the Eigenbeams will contain (spatially) aliased components and should be treated with care.
The EigenUnit-em32-Encoder plugin has the following parameters:

- **Ambisonics Order** – this parameter specifies the order up to which the signals should be encoded. Lowering this maximum order will reduce CPU load. However, the order should always be set to be compatible with subsequent plugins (e.g. If using a third-order HOA decoder, make sure to set this parameter to 3\textsuperscript{rd} or higher!). For Ambisonics order $N$, the plugin will output $(N+1)^2$ signals.

- **Output Normalization** – this parameter specifies the normalization scheme that will be applied to the encoded Eigenbeam (spherical harmonic) output signals. Available schemes are: SN3D, N3D, MaxN, and FuMa. See the Appendix for a complete description of these normalization schemes.

- **Output Channel Ordering** – this parameter specifies the channel ordering of the encoded Eigenbeam (spherical harmonic) output signals. Available options are: ACN and FuMa. See the Appendix for a complete description of these ordering schemes.

Care should be taken to configure the Encoder settings properly for compatibility when interfacing with third-party HOA plugins. Specifically, the “Output Normalization” and “Output Channel Order” Encoder parameters should be set to match the format expected by the subsequent HOA plugins (see manufacturer’s documentation for details).
4.4 EigenUnit-em32-Beamformer

The EigenUnit-em32-Beamformer VST plugin accepts the 32 calibrated microphone signals from the Control plugin (or from file), and produces a single-channel beamformed output according to the parameters set by the user. The beamforming capabilities cover a wide range of possible applications. Users can specify the pattern type (omnidirectional, cardioid, supercardioid, hypercardioid, dipole), the pattern order (0th through 4th), as well as steer the look-direction of the beam in full 3D space.

![Beamformer plugin interface](image)

*Figure 6: The Beamformer plugin interface*

---

9 Note that unlike the previous Audio Unit (AU) version of this plugin, which accepted the Eigenbeams as inputs, the VST EigenUnit-em32-Beamformer takes in the 32 calibrated mic signals from the em32, and includes the high-frequency extension internally.
The EigenUnit-em32-Beamformer plugin has the following parameters:

- **Beampattern** – this parameter specifies the directionally dependent sensitivity of the beamformer’s output. The 32 input signals will be combined to realize the specified beampattern. The Beamformer plugin allows the choice between 14 different beampatterns: omnidirectional, cardioid (1\textsuperscript{st}, 2\textsuperscript{nd}, 3\textsuperscript{rd}, and 4\textsuperscript{th}-order), supercardioid (1\textsuperscript{st}, 2\textsuperscript{nd}, 3\textsuperscript{rd}, and 4\textsuperscript{th}-order), hypercardioid (1\textsuperscript{st}, 2\textsuperscript{nd}, 3\textsuperscript{rd}, and 4\textsuperscript{th}-order), and 1\textsuperscript{st} order dipole. See the appendix for more details.

- **Vertical Look-Direction**: This is the look-direction (direction with maximum sensitivity) of the beam in the vertical dimension. It is in degrees and ranges from 0 to 180. The 0 degrees direction points away from spherical array from the top (the opposite side from where the shaft mounts to the Eigenmike; towards the ceiling in a typical arrangement). The 90 degrees direction is the horizontal plane, and the 180 degrees direction is in the direction of the shaft (towards the floor).

- **Horizontal Look-Direction**: This is the look-direction (direction with maximum sensitivity) of the beam in the horizontal plane. It is in degrees and ranges from 0 to 360. The 0 degrees direction aligns with the “mh acoustics” logo on the shaft of the Eigenmike. The angle increases in the counter-clockwise direction.

![Figure 7: Spherical coordinate system conventions](image)
5. Appendix

5.1 Eigenbeam Ordering and Normalization

The EigenUnit-em32-Encoder allows the user to select from various Eigenbeam normalization and channel ordering schemes. All of the schemes are well-known and utilized to some extent in the Higher-Order Ambisonics (HOA) community.

When using the Encoder plugins in conjunction with third-party Ambisonic plugins (e.g. an HOA decoder), it is very important to set these EigenUnit parameter values appropriately to match the expectation of the third-party plugin. For example, when using Blue Ripple Sound’s O3A Core\textsuperscript{10} suite of VSTs with the EigenUnits, the Eigenbeam normalization should be set to “SN3D” and the channel ordering to “ACN”. As another example, when using Matthias Kronlachner’s ambiX plugins\textsuperscript{11}, the Eigenbeam normalization should be set to “SN3D” and the channel ordering to “ACN”.

An excellent (but still under-construction) resource for learning more about HOA normalization and channel ordering schemes can be found in the Wikipedia page on “Ambisonic data exchange formats”\textsuperscript{12}, as well as in the references cited by that article.

\textsuperscript{10} http://www.blueripplesound.com/products/o3a-core-vst
\textsuperscript{11} http://www.matthiaskronlachner.com/?p=2015
\textsuperscript{12} https://en.wikipedia.org/wiki/Ambisonic_data_exchange Formats
## 5.2 Troubleshooting

<table>
<thead>
<tr>
<th>SYMPTOM</th>
<th>POSSIBLE REMEDIES</th>
</tr>
</thead>
</table>
| The Control plugin does not recognize the em32/EMIB hardware (the “PGA Gain” slider has no effect on the level of the signals from the EMIB). | - Make sure the EMIB is powered on. The EMIB should be powered on and connected to both the computer and the em32 before launching the host application or loading the EigenUnits.  
  - Make sure you have installed the Core Audio drivers for the EMIB interface ("TCAT Dice" drivers). These can be obtained from the mh acoustics website: [https://mhacoustics.com/download](https://mhacoustics.com/download)  
  - Check that the OS recognizes the EMIB as a valid, connected audio interface. In macOS, launch the application "Audio MIDI Setup" and confirm that the "TCAT Dice EVM Platform" audio device shows up in the list of connected audio devices.  
  - Try rescanning for the MIDI device. Launch the macOS application "Audio MIDI Setup". From the Window menu, select "Show MIDI Studio". Click "Rescan MIDI" and confirm that the "TCAT Dice EVM Platform" device shows up as a valid MIDI device and is not grayed out.  
  - In Cockos Reaper, you may need to enable the MIDI device. Go to Preferences->Audio->MIDI Devices and right-click on the TCAT device and select “Enable”. Do this for both input and output. |
| No input signal is observed in the DAW.                                 | - Consult the DAW manufacturer’s manual to ensure you have correctly connected the software inputs.  
  - Make sure the audio input device is set to the EMIB ("TCAT Dice EVM Platform").  
    - Max: Options->Audio Status->Device  
    - Reaper: Preferences->Audio->Device  
  - Use the Control plugin to confirm that the EMIB and em32 have been detected by the system. If they are not detected, follow the troubleshooting steps above.  
  - Make sure that the clock source for the EMIB (TCAT Dice) device is set to "Internal" via macOS Audio MIDI setup (or if using an external word clock, make sure it is connected to the BNC “Word Clock In” on the back of the EMIB and is a valid 44.1 or 48kHz signal). |
| No signal is observed at the output of one or more of the EigenUnit plugins. | • Consult the DAW manufacturer’s software manual to ensure you have signal monitoring enabled and that hardware/software signal routing is correct.  
  • Make sure your DAW is setup to use a sampling rate of 44.1 or 48 kHz. |
|---|---|
| An output signal is observed in the software DAW, but not at the EMIB’s hardware outputs. | • Make sure the audio output device is set to the EMIB ("TCAT Dice EVM Platform").  
  ○ Max: Options->Audio Status->Device  
  ○ Reaper: Preferences->Audio->Device  
  • Try restarting the DAW.  
  • Try testing the EMIB audio output by generating a signal from another piece of software (e.g. iTunes) and setting the TCAT Dice as your system’s audio output.  
  • Make sure the output signals are routed to the desired EMIB output\(^\text{13}\) |
| Output signal does not seem correct, or is too low in level. | • The EigenUnit-em32-Control plugin should be used to increase the PGA gain and apply internal calibration of the em32.  
  • The EigenUnit-em32-Encoder MUST be configured with the correct normalization and channel ordering. If using this plugin with third-party plugins (e.g. HOA Decoders), make sure these parameters are set to the values expected by the third-party plugin. Refer to the third-party manufacturer’s documentation for details. |

For additional assistance, please contact us: contact@mhacoustics.com

---

\(^{13}\) On a standard EMIB, output channels 1-2 = front-panel headphone jack output; channels 3-10 = back-panel ADAT output.